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Genetic toggle switch
Synthetic biology uses well-characterized biological components to construct genetic circuits
with a desired function, analogous to the circuits used in electrical engineering. Such genetic
circuits can implement some of the same functions as their electronic counterparts. In particular, a genetic toggle switch has a function analogous to a flip-flop in electronics: it exhibits
two stable steady states and can thus store 1 bit of information. However, the components of
these circuits are not capacitors, resistors, transistors, etc. but genes from living organisms —
most often, transcription factors and promoters from bacteria like Escherichia coli. Theoretical
descriptions of gene regulation play a key role in designing synthetic gene circuits. Thermodynamic models of gene regulation and concepts from dynamical systems theory are crucial
for the design of gene circuits and for understanding their dynamics. In this experiment, the
design of a genetic toggle switch is analyzed, and its switching between two stable states is
observed in living bacteria.

1
1.1

Background and introduction
Synthetically controlling gene expression

The essential building blocks of synthetic gene regulatory circuits such as the toggle switch
[6] or the “repressilator” [4] are promoters and transcription factors which are usually derived
from bacteria. Particularly important are inducible promoters; the transcription of the genes
controlled by such a promoter can be controlled by changing the external concentration of an
inducer. Thus, inducible promoters provide a simple way of switching genes on and off and
even enable more quantitative control of their expression level. To understand the design of
the toggle switch circuit, we first introduce key features of the promoters and transcription
factors used.

Figure 1: Inducible control of the lac promoter using IPTG. Schematic of 1: RNA Polymerase, 2: Repressor,
3: Promoter, 4: Operator, 5: Lactose, 6-8: lac operon or other genes under the control of the lac promoter.
Top: The promoter is essentially turned off. There is no lactose or IPTG to inhibit the lac repressor, so the
repressor binds tightly to the operator, which obstructs the RNA polymerase from binding to the promoter.
Bottom: The promoter is turned on. Lactose inhibits the repressor, allowing RNA polymerase to bind to the
promoter and express the downstream genes. Figure from Wikipedia.

Commonly used inducible promoters include the lac promoter and the tet promoter.
In both cases, the transcription from the promoter is repressed by a transcription factor (the
lac repressor LacI and the tet repressor TetR, respectively) that binds to the promoter region
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and prevents transcription. These repressors can bind to specific inducers (isopropyl β-D1-thiogalactopyranoside (IPTG) and anhydrotetracycline (aTc), respectively). The binding of
these inducers to the repressors leads to a change in protein conformation and a resulting
change in affinity for the binding site in the promoter region (allosteric regulation; Figure 1).
The small molecules IPTG and aTc are synthetic variants of the sugar lactose and the antibiotic
tetracycline, respectively, which are sensed by these repressors in the natural system. The
advantage of IPTG and aTc is that they have virtually no other effect on the cell than changing
the binding affinity of the respective repressor and can thus be used to control the expression
from these promoters; in particular, IPTG — unlike lactose — does not get degraded by the
lactase enzyme (LacZ).
In a typical experiment, the inducible promoters control a reporter gene (e.g. a fluorescent
protein such as GFP) and are put on the chromosome or on a plasmid inside a bacterium like
Escherichia coli. These bacteria are then cultured in growth medium that can be supplemented
with the respective inducer. Increasing the inducer concentration in the growth medium leads
to a continuous increase expression level. An expression level change over several orders of
magnitude is readily achieved in this way (Figure 2).

Figure 2: Induction curves for inducible promoters. Left: Expression from the tet promoter (PLtetO−1 ) as a
function of aTc concentration. Right: Expression from the lac promoter (PLlacO−1 ) as a function of IPTG
concentration. Expression from the promoters is quantified using luciferase activity (y-axis). For details,
see [8].

1.2
1.2.1

Theory
Thermodynamic models of gene regulation

The shape of the induction curves (Figure 2) is important for the dynamics of genetic circuits.
This shape can be quantitatively understood using thermodynamic models of gene regulation.
The central assumption of these models is that the binding of transcription factors to their
binding sites in the promoter region and the binding of RNAP to the promoter are in thermodynamic equilibrium. Thus, the binding probability of the transcription factors and RNAP
are determined by their binding energies. Further, these models assume that the transcription
rate from a promoter depends only on the probability that RNA polymerase (RNAP) is bound
to the promoter region.
In one of the simplest examples, there is a single repressor binding site and RNAP can no
longer bind when this site is occupied by the repressor; the transcription rate of the promoter
is thus proportional to one minus the probability that the repressor is bound. In this case, a
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thermodynamic model of gene expression [1, 2] predicts that the transcription rate f from the
promoter depends on the active repressor concentration R as
f∝

1
.
1 + KRR

Here, KR is the effective equilibrium dissociation constant of the repressor and its binding
site. Even though it is not clear if their underlying assumptions hold generally in living cells,
thermodynamic models of gene regulation successfully explain observed regulation functions
like those in Figure 2 in many cases (note that increasing the inducer concentrations in Figure
2 corresponds to decreasing the concentration of active repressors).
1.2.2

Cooperativity

As apparent in Figure 2, the steepness of the regulation function, i.e. the relative change in
expression level resulting from a given relative change in active TF concentration, can be considerably different for different inducible promoters. This phenomenon can be partly explained
by the presence of multiple repressor binding sites in the promoter region. The binding of repressors to these sites is often cooperative, i.e. it is more likely for a second repressor to bind
to one of the remaining binding sites when a repressor is already bound to a different binding
site. For example, a thermodynamic model with two repressor binding sites and an interaction
between the bound repressors yields a transcription rate
f∝

1
1 + KRR +

R2
2 ω
KR

,

(1)

where ω depends on the interaction between the two bound repressors [1, 2]. This result
highlights that cooperative binding of multiple repressors leads to a steeper regulation function than that of a single repressor. We will see below that this increased steepness is crucial
for constructing a bistable genetic switch.
1.2.3

Design of the toggle switch circuit

The toggle switch circuit consists of two promoters, each of which controls the expression of
the repressor of the other promoter, respectively (Figure 3). The idea is that this design can
lead to two distinct states of gene expression that are stably maintained over long times: (a)
promoter 1 is highly expressed, leading to many copies of repressor 2 in the cell which shut
down promoter 2; (b) promoter 2 is highly expressed, leading to many copies of repressor 1,
shutting down promoter 1. In the specific implementation used in this experiment, the lac
promoter (repressed by LacI) controls the expression of tetR while the tet promoter (repressed
by TetR) controls the expression of lacI (Figure 3). The tet promoter additionally controls the
expression of a gfp gene and the lac promoter controls an mcherry gene; these genes code for
green (gfp) and red (mcherry) fluorescent proteins (GFP and RFP), respectively. Consequently,
the state of the system can be read out in living cells using fluorescence measurements. The
state of the system can be flipped by adding the inducers IPTG or aTc, respectively.
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Figure 3: Genetic toggle switch. Left: Common electrical toggle switch with a mechanical lever. The goal
here is to construct an analogous switch with two stable states using a genetic circuit in a living cell. Middle:
general design of a genetic toggle switch [6]. Right: specific circuit used in this experiment [7]. IPTG and
aTc can be used to flip the toggle switch from the green to the red state and vice versa.

1.2.4

Theoretical description of the toggle switch circuit

We describe the intracellular concentrations of LacI and TetR using the following dynamical
system:
dcLacI
=
dt

1+

νLacI
β − gcLacI

cTetR
KTetR

dcTetR
νTetR

γ − gcTetR
=
dt
1 + KcLacI
LacI

(2)

Here, cLacI and cTetR denote the intracellular concentrations of LacI and TetR, respectively.
νLacI and νTetR are the maximum synthesis rates of LacI and TetR, KTetR and KLacI are the
effective equilibrium dissociation constants of these repressors to their binding sites in the
promoter region. The exponents β and γ can capture cooperative repression of the promoters (when β, γ > 1) similar to Eq. (1), and g is the specific growth rate, which leads to an
effective degradation term due to dilution of proteins resulting from growth and cell division. To analyze this dynamical system, it is convenient to first nondimensionalize Eq. (2), i.e.
measure time in units of g −1 and define u = cLacI /KLacI and v = cTetR /KTetR . Introducing
α1 = νLacI /gKLacI and α2 = νTetR /gKTetR , the non-dimensionalized dynamical system reads
[6]
α1
du
=
−u
dt
1 + vβ
dv
α2
=
− v.
dt
1 + uγ
1.2.5

(3)

Fixed points, stability, and bifurcations of the toggle switch circuit

It is not clear that the circuit design in Figure 3 actually leads to a bistable system. Indeed,
this depends on the parameter values of the system in Eq. (3) and, in particular, on the shape
of the regulation functions of the two promoters. To understand how bistability can occur in
this system, we briefly summarize a graphical analysis of the system using standard concepts
from dynamical systems theory [3, 9].
We first identify the fixed points, i.e. the steady states of the system, where du/dt =
dv/dt = 0. From drawing the nullclines (i.e. the lines where du/dt = 0 and dv/dt =
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0, respectively) in the (u, v)-plane (Figure 4a), we see that the system can have up to three
fixed points if β, γ > 1 (the fixed points are located where the nullclines intersect). Two of
these fixed points are stable (i.e. the system will return to these fixed points upon a small
perturbation); hence, the system is bistable. These stable fixed points correspond to two
opposite gene expression states: one state with high u and low v and another state with high
v and low u; the third fixed point (where u and v have similar values) is unstable. The two
stable fixed points correspond to the two states of a toggle switch.
All three fixed points exist only in a certain parameter regime. E.g., if we lower the value of
α2 , the dv/dt-nullcline is scaled down along the v-axis (Figure 4b) and two of the intersections
with the du/dt-nullcline disappear at a critical point: one of the stable fixed points and the
unstable fixed point annihilate in a saddle-node bifurcation [3]; only a single fixed point
(with high u) remains. These considerations show that while the toggle switch circuit can
exhibit bistability, this is only the case in a suitable parameter regime.

Figure 4: Graphical analysis of the toggle switch equations. (a) Nullclines and fixed points of Eq. (3). (b)
As a but for a lower value of α2 . (c) The number of stable fixed points is dependent on parameters (α1 , α2 ).
Saddle-node bifurcations occur when the solid lines are crossed. (d) As c but for different values of β, γ as
shown. For details, see [6].

Further analysis shows that α1 and α2 have to be sufficiently similar for bistability to occur
(Figure 4c). Importantly, bistability can only occur if at least one of the exponents β, γ is
greater than 1 (Figure 4d). We can see this graphically: if both β = 1 and γ = 1, the nullclines
lose their sigmoidal shape (Figure 4a) and become hyperbolic, leading to a loss of two of the
intersection points. Hence, a nonlinearity leading to a steep regulation function with β, γ > 1
is crucial for generating a bistable system using the design of two mutually repressing genes
(Figure 3).
1.2.6

Switching between the stable fixed points

Due to inevitable fluctuations of the TF molecule numbers in each cell, the system can spontaneously switch from one stable state to the other. The kinetics of switching can be described
in a variant of Eq. (3) that contains noise terms capturing these fluctuations. Starting with the
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system in one of the stable states (in a parameter regime as in Figure 4a), the rate of switching
to the other state is low because a large fluctuation is needed to push the system across the
separatrix. An effective way to increase the switching rate is to add a suitable inducer (IPTG
or aTc): this deactivates some of the TF molecules, thus lowering the respective concentration
of active TF (u or v) and pushes the system closer to the separatrix in Figure 4a. This in turn increases the rate of switching to the distal fixed point since smaller fluctuations in TF molecule
numbers are now sufficient for crossing the separatrix. Thus, the rate of switching increases
with increasing inducer concentration. In this experiment, we will validate this behavior and
measure how the switching rate depends on the inducer concentration.

1.3
1.3.1

Experimental techniques
Population level measurements of growth and fluorescence

To determine the average state of the synthetic toggle switch circuit shown in Figure 3 in a
population of cells, the intracellular concentration of the green and red fluorescent protein
needs to be measured. A simple way of doing this at the population level is by measuring the
total fluorescence intensity and normalizing it to the total biomass of the population of cells
[10]. The biomass of a growing bacterial culture can be determined using an optical density
(OD) measurement; it is approximately equal to the total cell volume. To measure OD, the
sample volume is placed in a cuvette or microtiter plate and the absorbance of a light beam
is measured in a spectrophotometer. This instrument shines light (usually at 600 nm) through
the sample, measures the decrease in light intensity after passing through the sample, and
determines the absorbance based on the Beer-Lambert law. The absorbance is approximately
proportional to the biomass density of the culture. By following optical density over time, the
specific growth rate of the culture can be determined.
1.3.2

Single-cell fluorescence measurements

A hallmark of a bistable gene expression circuit is that individual cells are generally in either
one of two distinct gene expression states (unless they are just in the process of switching from
one state to the other). As a result, the distribution of gene expression levels is bimodal. To
test this property, the fluorescence of individual cells needs to be observed. Common ways of
doing this are flow cytometry (Figure 5) and fluorescence microscopy [5] where individual
cells are directly visualized.

Figure 5: GFP fluorescence signal from individual toggle switch cells measured using flow cytometry.
Switching was induced at time zero and is complete after 6h. Figure from [6].
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Goals and tasks

The goal of this experiment is to observe and quantify key properties of a genetic toggle switch.
Specific tasks:
1. Inoculate E. coli bacteria that carry a toggle switch circuit and expose them to different
concentrations of the inducers IPTG and aTc, respectively.
2. Quantify the kinetics of switching between the two stable expression states as a function
of inducer concentration.
3. Validate that the toggle switch has two clearly distinct stable expression states in individual cells.

3

Experimental procedure

Note: This experiment typically takes ∼7 hours (including a lunch break).
1. Set up an IPTG and an aTc concentration gradient in glucose M9 medium (with
amino acids) on a 96-well plate. Use the maximum concentrations 2 mM for IPTG and
100 ng/mL for aTc and perform 2-fold dilutions to cover ∼2 orders of magnitude of
concentration. Also include control wells with zero concentration of both IPTG and
aTc, respectively.
2. Use a multi-channel pipette to inoculate the wells containing the IPTG concentration
gradient from an overnight culture of the toggle switch strain in the green state (final dilution 1:100). In the same manner, inoculate the wells containing aTc from the
overnight culture in the red state.
• Optional: Put the overnight cultures under a bright light source and take a photograph (the GFP or RFP fluorescence may be visible with the naked eye).
3. Incubate the 96-well plate at 37°C with shaking at 1,000 rpm. Measure optical density
(OD600 ), GFP and RFP fluorescence in a plate reader every ∼30-40 min for ∼4-5
h total.
4. In the meantime, take images of a few hundred individual cells from the overnight cultures in the red and green state, respectively. To this end, cut small (∼1 cm2 ) agar pads
from an agar plate, put a ∼1 µL drop of culture on each pad, let it dry for a few minutes,
and put it on a cover slip. Then take images of the cells in both the GFP and RFP channels
of the fluorescence microscope (using the 100× objective).
5. After ∼2-3 h, when the GFP signal should have clearly increased for the cultures at the
higher IPTG concentrations (compared to zero IPTG) and the RFP signal should have
increased at the higher aTc concentrations, take microscope images of at least a
few hundred cells from one well each at a high IPTG and aTc concentration,
respectively. In the same manner, take images of cells from the two wells at zero IPTG
and aTc concentration as a reference, respectively.
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Analysis

Include error estimates for all quantities that are calculated (in particular, the growth rates,
switching rates, and fractions of cells in the different states of the toggle switch). Make sure
to follow the instructions for writing the report (see course website).
1. For all cultures, subtract the OD background (e.g. from a well with growth medium but
no cells) and plot the OD over time in a semi-log plot. Quantify the growth rates
using an exponential fit. Does IPTG or aTc affect the growth rate?
2. For all cultures, plot GFP/OD and RFP/OD (which correspond to the fluorescence signal
per cell volume) over time. Alternatively, you can approximate the total cell volume
by GFP+RFP and plot GFP/(GFP+RFP) and RFP/(GFP+RFP) over time (here, you need to
normalize the GFP and RFP signals so that the same number of cells corresponds to the
same normalized fluorescence signals for both fluorophores). Estimate the rates of
switching from the green state to the red state and vice versa at different concentrations of IPTG and aTc. To this end, assume that switching happens at a constant rate
and perform suitable exponential fits to the data. What is the minimal IPTG and aTc
concentration that can flip the switch, respectively?
• Optional: correct for non-specific fluorescence and bleed-through by subtracting
the GFP and RFP fluorescence background. A good way of doing this is to subtract
the fluorescence signal of interest (e.g. GFP) at the same OD from a culture that
expresses only the other fluorophore (e.g. RFP).
3. Include a few sample fluorescence images in the protocol, ideally showing the signal in
the GFP and RFP channels in a merged color image. Segment the microscope images
and quantify the fluorescence intensities from single cells. To this end, use a program
such as Fiji, ImageJ or Matlab. Here is a simple way of segmenting an image:
• Download Fiji from https://fiji.sc/ and start this program.
• Go to File → Import → Bio-Formats and open one of the .nd2 files. Make sure
the ‘Split channels’ option is activated. You will get three images open, one for
mCherry, one for GFP, and one for the transmitted light channel. We will identify
the cells based on the transmitted light image and then evaluate the fluorescence
of these cells in the mCherry and GFP layer.
• Segment the transmitted light image by thresholding: Image → Adjust → Threshold; choose ‘Otsu’ from the left pull-down menu, make sure that “Dark background” is NOT ticked, and click ‘Auto’ (do not click ‘Apply’).
• In Analyze → Set Measurements make sure that “Mean gray value” and ‘Median’
is checked.
• Obtain fluorescence intensities from individual cells: Analyze → Analyze Particles; enter Size = 100-1000 pixelˆ2 (or 0.5-5 micronˆ2), Circularity 0.00-1.00; choose
‘Outlines’ from the pull-down menu; check “Display results” and “Add to manager.”
• This will produce a mask with outlines of cells added to the ROI manager and a list
of mean, minimum, and maximum fluorescence intensities for the individual cells.
These values, however, relate to the transmitted light image. We want to get these
values for the mCherry and GFP images, using the mask from the transmitted light
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image. Thus, clear the results form the ‘Results’ window, activate the mCherry
layer of this image, and click ‘Measure’ in the ROI manager. This will produce
a list of mCherry fluorescence values. Copy that list into a spreadsheet for later
processing. Clear the results from the ‘Results’ window and repeat for the GFP
values.
• Repeat the above steps for the rest of your images, keeping track of which measurements are in the GFP and which in the mCherry channel.
4. Plot histograms with logscale x-axis of the single-cell GFP and RFP intensities for the
different cultures and time points you measured (make sure to log-transform the data
before binning, so that you get bins of equal size on log-scale):
• Overnight cultures in the red and green state, respectively.
• Culture that started from the green state, after 2-3 h in IPTG.
• Culture that started from the red state, after 2-3 h in aTc.
5. Quantify the fraction of cells in the red and green state, respectively, and plot it for
the two time points (stationary phase cells = time zero). Estimate the switching rate in
the presence and absence of IPTG or aTc, respectively, from these data (again assuming
that switching happens at constant rate). Compare the result to that obtained from the
plate reader measurements (see point 2 above).
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